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Introduction

You’ve probably heard a lot about Mac OS X 10.4 “Tiger.” After all, Apple 
has been talking about it for months, showing off its great new features at 
trade shows and on the Apple Web site. When Tiger was ready for release, 

Apple started a countdown right on the Apple Web site’s home page. Then, at 
6:00 PM sharp on Friday, April 29, 2005, the doors to Apple Stores opened and 
Tiger was on the shelves.

I was fortunate enough to be one of very few authors who received pre-
release versions of Tiger as it was being developed. When Apple announced 
Tiger’s release date, my book, Mac OS X 10.4 Tiger: Visual QuickStart Guide 
went to the printer. And, on April 29, my book was one of the few Tiger books 
on Apple Store shelves, ready to help Tiger buyers get the most out of Mac OS X.

1
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Get Excited
I started working with Tiger early in 2005 and was soon very excited about it. No doubt about it—Tiger is 
the best update to Mac OS X so far. I couldn’t wait to get the release version so I could install it on my 
production Mac and use it every day.

What’s new: the obvious
Apple made a lot of noise about some of Tiger’s new features:

4 Spotlight, the new and improved searching feature, is lightning fast, powerful, extendable, and avail-
able throughout Mac OS X.

4 Dashboard puts a wide variety of tiny and useful applications called widgets at your fingertips when 
you need them.

4 Automator makes it possible to automate repetitive tasks without being a programmer.

These are the cool features, the ones that look good in demos and help convince Mac OS X users to 
upgrade.

But wait! There’s more!
Mac OS X 10.4 Tiger includes other features that weren’t so widely advertised but are just as likely to 
make Mac OS users want to upgrade:

4 Finder includes three new commands: Smart Folders enables you to automatically organize files and 
other items in the Finder, Burn Folders help you organize items to be burned onto a CD or DVD disc, 
and Print makes it possible to print selected documents from the Finder.
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4 Family Controls, which is also referred to as Parental Controls, make it possible to limit the access for 
a user account.

4 .Mac Sync offers new synchronization options for .Mac members who have multiple computers. 

4 Safari now has built-in RSS support so you can switch from standard Web page browsing to RSS 
browsing by simply visiting the address for the RSS feed.

4 iChat AV can now support video conferencing or audio conferencing between more than just two 
people.

4 Mail uses Spotlight technology for searching, smart folders for automatically organizing messages, 
and a slide show feature to view photo attachments to messages you receive.

4 Address Book now enables you to share your address book with other 
.Mac members and organize addresses with smart groups.

And, as you work with Mac OS X 10.4, you’re likely to find dozens of 
other new features tucked into Mac OS X applications such as System Prefer-
ences, TextEdit, Preview, iCal, QuickTime, and more. 

About this eBook
I wrote this eBook to help introduce Tiger users to the new features of Mac OS X 10.4 Tiger. Although you 
can learn what the new features are on Apple’s Web site and fiddle around with Mac Help to get basic 
instructions, you’ll probably find it more convenient to learn about the new features in one place.

200+ New Features
Apple says there are more 
than 200 new features in 
Mac OS X 10.4 Tiger; you 
can read a list for yourself 
at www.apple.com/
macosx/newfeatures/
over200.html.

http://www.peachpit.com/title/0321305264
http://www.peachpit.com/title/0321305264
http://www.peachpit.com/title/0321305264
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What’s in this book
This eBook introduces the best of Mac OS X 10.4’s new features—the ones listed in this introduction—
and explains how you can get started using them. It also provides a bunch of tips with insight on how you 
can use the new features to get your work done faster so you can get on with other more important things, 
like your life.

How to use this book
This book was designed to be read onscreen—in fact, it was format-
ted for a computer screen with 800 x 600 resolution. That’s why the 
font characters are so darn big. I don’t want you to strain your eyes 
reading it.

eBooks have features that just can’t be included in printed 
books. Hyperlinks, for example, make it possible to quickly zoom 
to another page in this document or open a Web page with your 
Web browser. (You can identify hyperlinks in the text by font and 
color: they’re bold and blue.) The Table of Contents is full of hyper-
links you can use to find content quickly. And every URL in this 
document is also a clickable hyperlink. Click one to see for your-
self.

This eBook utilizes the bookmark feature of Adobe Acrobat to 
create a list of headings you can click to get to a specific page 
quickly. It’s like a table of contents you can keep onscreen without 
flipping back and forth to the real Table of Contents. This feature 
works whether you’re reading this book with Adobe Reader or 
Preview.

Tips for reading this eBook
4 Click the Zoom button in the 

document window’s title bar to 
zoom the window to full size. (If 
you prefer, you could drag the 
window’s size box to resize it.)

4 If you’re reading this eBook with 
Adobe Reader, press Command-
0 (zero) to zoom the document 
so it fills the window.

4 If you’re reading this eBook with 
Preview, choose View > PDF 
Display > Single Pages to view 
one full page at a time.

4 To view the bookmark list in 
Adobe Reader, choose View > 
Navigation Tabs > Bookmarks (or 
just click the Bookmarks naviga-
tion tab).

4 To view the bookmark list in 
Preview, click the Drawer button 
on the toolbar.
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You can also use the search feature of Adobe Reader or Preview to search this book for a specific word 
or phrase. Click one of the search results to zip to where the topic you’re searching for is covered. (Don’t 
you wish you could do that with a printed book?)

An eBook is also extremely portable. Put it on your PowerBook or iBook and take it with you when 
you’re on the road. It doesn’t weigh a thing.

Of course, if you’re an old-fashioned kind of reader, you can always print out this eBook and read it 
from paper. You might find, however, that the screen shots aren’t quite as clear as they appear on screen. 
To keep the file size of this eBook within reason, I had to downsample all of the screenshots. If I didn’t, it 
would take you hours just to download the file!

If You Need More
This book is not a comprehensive guide to Tiger. It’s also not a guide for brand 
new Mac OS X users to learn the ins and outs of Mac OS X. 

A shameless plug for  
Mac OS X 10.4 Tiger: Visual QuickStart Guide
If you need more information about using all of Tiger’s 
features, you really should check out my Peachpit Press 
book, Mac OS X 10.4 Tiger: Visual QuickStart Guide. 

The book, which weighs in at a hefty 720 pages, 
covers everything from installing Tiger and learning to 
point and click to exploring Unix and customizing the 

Finder. Although its pictures are not in color like the ones in this book, the 

Why this eBook 
doesn’t have more
If this eBook had the 
same content as Mac 
OS X 10.4 Tiger: Visual 
QuickStart Guide, my 
editors at Peachpit 
would be very angry 
with me. Since they’re 
nice people and they 
pay me to write books 
for them, it’s in my best 
interest to remain on 
their good side.
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pages are already printed. There’s even a 20-page index at the end of the book to help you find the infor-
mation you need quickly. Sadly, at 2 lbs 8 oz, it isn’t as portable as some people would like.

And now for the special offer
If you decide you’d like a copy of the book and you’d rather get it for less 
than retail price, you’re in luck. With the assistance of those nice people at 
Peachpit Press, I’m able to offer the book at a discount to readers of this 
eBook.

Here’s the deal. The book normally sells for $24.95, but you can get it for 
35% off the retail price (for a limited time) if you demonstrate your ability to 
follow these instructions:

1. Use your Web browser to visit www.peachpit.com/title/0321305264.

2. Click the Add to Cart button. (Don’t worry about the price now. We’ll fix that momentarily.)

3. In the shopping cart page that appears, modify the quantity you’d like to buy if necessary. (Obviously, 
I’d like you to buy copies for all your friends and family members, but I’ll understand if you don’t. The 
book does take up a lot of shelf space.) 

4. Click the Proceed to Checkout button.

5. Enter your billing and shipping information in the form that appears and click Continue.

6. Choose a shipping method option in the form that appears. (UPS shipping may be free, depending on 
where you live.) Then click Continue.

7. Enter EE-DTST-GRP in the promotional code box on the page that appears. This is very important 
because this is what gets you the discount, so don’t skip this step.

8. Enter payment information in the rest of the form and click Continue.

Other places  
to get the book
Here are three other 
places you can get the 
book online at a discount:
4 Peachpit Press
4 Amazon.com
4 Barnes & Noble.com

http://www.peachpit.com/title/0321305264
http://www.peachpit.com/title/0321305264
http://www.amazon.com/exec/obidos/ISBN=0321305264/gilesroadpressA/
http://search.barnesandnoble.com/booksearch/isbnInquiry.asp?isbn=0321305264&itm=2&userid=hC1gBoBA4l
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9. The final form shows the total of your order plus 
shipping and tax, minus the discount. Click Place 
Order.

Now tell your friends how they can order the book for 
35% off. They’ll thank you for your thoughtfulness.

About Me & This Series
If you’re wondering who the heck I am and why I deserve to get a series of books named after me, here’s 
the scoop.

Who I am
I’m a freelance writer who has been writing about computers since 1990. I’ve written about 60 books—
the printed kind, that is—most of which were published by Peachpit Press. I’ve also written hundreds of 
articles for newsletters, magazines, Web sites, and computer-related blogs.

My first computer was an Apple //c, which was followed up with a Macintosh in 1989. Since then, I’ve 
gone through about a dozen Macs in an effort to keep current. Today I sit in front of a dual processor G5 
with an eMac beside me as my “test mule.” Although I’ve been known to write about Windows software, I 
use Macs for all my computing needs, including my e-mail and Web server.

What this series is all about
The Maria’s Guide series was created in an effort to share information on a timely basis with folks who 
recognize the value of electronic publishing. 

Limited time means limited time
I’ve been told that this discount is only avail-
able until 12/31/2005. But it may expire 
sooner. If the discount doesn’t appear in step 
9, you missed out. Try Amazon.com; they’re 
usually pretty good about offering discounts.

http://www.marialanger.com/books.html
http://www.peachpit.com/
http://www.marialanger.com/articles.html
http://www.marialanger.com/articles.html
http://www.amazon.com/exec/obidos/ISBN=0321305264/gilesroadpressA/
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eBooks can be released quickly and inexpensively. Because they require fewer resources to prepare, 
they can cover a wide variety of topics that a print publisher wouldn’t consider worthwhile. After all, print 
publishers have a huge staff of people for production and marketing, as well as enormous expenses for 
printing and distribution. eBooks can be created with a much smaller staff of people and lower per unit 
costs. This makes it possible to release titles about topics that appeal any market, no matter how small.

This is the first book in the Maria’s Guide series. Three more titles are planned for release  
within the next few months. You can find all eBooks in this series at the Maria’s Guide Web site  
(www.langerbooks.com/mariasguides/).

Important Copyright Information
While it’s true that this eBook is a downloadable file that’s easily copied from hard disk to CD or e-mailed 
across the world, it’s not true that it’s freely distributable.

This book is copyrighted
Like most other books, this eBook is protected by copyright law. As the book’s purchaser, you can read it 
on any of your computers. You can even back it up to a CD as an archive or to view it on another com-
puter.

You may not, however, make copies of it to share with friends, family members, or co-workers. And 
you certainly may not upload it to Web or FTP sites for distribution to others.

maria.10quicksteps.com
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Why does this matter? 
Well, it’s like this. I get paid for my work on this book (and all other books I write) based on the number of 
copies sold. I’m not compensated for illegal copies of my work. If I can’t earn enough to make writing and 
producing an eBook worthwhile, I’ll stop writing them.

It’s all up to you
Want to see more affordable and informative eBooks?

Here’s how you can help me keep writing and publishing eBooks: Tell your friends about this eBook, 
but don’t give them copies of it. Instead, send them to the Maria’s Guide Web site so they can buy their 
own copy.

Book Companion Web Site
You can find more information about using Mac OS X 10.4 Tiger on the companion Web site for Mac OS 
X 10.4 Tiger: Visual QuickStart Guide. That’s where you’ll find short “Quick Tips” articles, information 
about Mac OS updates, and more.

Use Safari to visit the site two ways:

4 Standard Web Pages: http://www.langerbooks.com/macosquickstart/

4 RSS Feed: feed://www.langerbooks.com/macosquickstart/B1779244120/rss.xml

And no, you don’t need to own the book to benefit from the information on this site. Stop in and 
check it out.

http://maria.10quicksteps.com/
www.langerbooks.com/macosquickstart/
feed://www.langerbooks.com/macosquickstart/B1779244120/rss.xml
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2New Finder Features

Some of Mac OS X 10.4’s best new features can be found 
right in the Finder. Look carefully under the File menu and 
you’ll find a bunch of brand new commands: New Smart 

Folder, New Burn Folder, and Print.

This chapter takes a closer look at these three new com-
mands. It explains how you can get started using them and 
includes a bunch of tips for using them to work more efficiently.
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Using Smart Folders
The Finder’s New Smart Folder command enables you to create...well, a 
smart folder. A smart folder is a folder that contains items that meet search 
criteria you specify.

You might be wondering why you should bother with a smart folder when 
you can always use the Finder’s Find command to search for items that meet 
your search criteria. In reality, these two features are very similar—and 
they’re related. A smart folder is basically a file that contains search criteria. 
When you open the smart folder, you tell the Finder to perform the search. 
The folder window displays the results. So, in effect, opening a smart folder is like using the Find com-
mand with all search criteria already set up. 

Creating a smart folder
There’s more than one way to 
create a smart folder, but I’ll tell 
you about the most obvious 
one: using the New Smart 
Folder command.

1. Choose File > New Smart 
Folder or press Option-
Command-N.

2. A New Smart Folder win-
dow appears. Set options at 
the top of the window to 
specify search criteria. 

Smart Folders  
and Spotlight
Smart folders use Spot-
light technology to 
quickly display search 
results. I cover Spotlight 
in Chapter 3.
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(Consult Chapter 3 for instructions on setting search criteria.) Search results appear immediately using 
Spotlight technology, as shown on the previous page.

3. Click the Save button.

4. Use the Save dialog that appears to enter a name and 
choose a location for the Smart Folder. If you want the smart 
folder to appear in the Sidebar, be sure to turn on the Add 
To Sidebar check box. Then click Save.

The title bar for the smart folder’s window changes to the 
name you specified. If you indicated that the smart folder should appear in the Sidebar, its icon appears 
there.

Opening a smart folder
Opening a smart folder is as easy as opening any other 
folder icon:

4 If the smart folder appears in the Sidebar, click it. 

4 If the smart folder is not in the Sidebar, locate its 
icon and double-click it.

The search criteria embedded in the smart folder is 
activated and the folder displays search results.
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Tips for working with smart folders
Here are a few tips for working with smart folders:

4 By default, smart folders are saved in the Saved Searches folder in the Library folder of your Home 
folder. You can move a smart folder to any location on disk.

4 Want to make smart folders easy to find without cluttering up your Sidebar with a bunch of icons? Add 
the Saved Searches folder to the Sidebar (or Dock). When you open that folder by clicking it, it dis-
plays the icons for all of your smart folders.

4 You can share your smart folders with friends and work associates. Just give them a copy of the smart 
folder icon. If the search criteria is not disk-specific, it should work on any Mac running Tiger.

4 If you’ve been reading carefully, you may remember that I said there was more than one way to create 
a smart folder. Another way is to click the Save button in the Searching window. You’ll see that win-
dow in Chapter 3.

4 You don’t have to keep a smart folder. If you don’t plan to ever use it again, just drag its icon to the 
Trash to delete it.

Using Burn Folders
The Finder’s New Burn Folder command creates—you guessed it—a burn folder. A burn folder is a special 
folder you can use to organize the files and folders you want to burn to CD or DVD disc.

You may be wondering why you should bother creating a burn folder when you can just as easily 
create a regular folder and copy the files you want to burn to disc to that folder. After all, that’s probably 
the way you did it with Mac OS X 10.3 Panther or earlier versions of Mac OS X. But using a burn folder is 
better. You see, when you drag files or folders to a burn folder, Mac OS X automatically creates aliases to 
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those items and displays the aliases in the burn folder. Then, when you burn the disc, the original files—
not the aliases—are copied to the disc.

Okay, you say, so what’s the big deal about that? Well, there are four main benefits to using burn 
folders:

4 Because the burn folder includes aliases rather than original files, the burn folder occupies less space 
on disk.

4 Because you’re not actually copying items to the burn folder, you can move items to it more quickly. 
(No need to wait until the files are copied.)

4 If any of the original items change before you burn the disc, the most recent version of the item is 
burned to disc. There’s no need to make a new copy in the burn folder.

4 Burn folders are saved to disk, so you can use them again and again. Every time you use a burn folder 
to burn a disc, the most recent version of its contents are burned to the disc automatically.

So although it might not be second nature to use a burn folder when burning files and folders to disc, 
it’s a good idea to make it a habit.

Creating a burn folder
The best way to create a burn folder is with the New Burn Folder command.

1. Open the folder where you want to store the burn folder—assuming you want to keep it.

2. Choose File > New Burn Folder. 

3. An icon for the burn folder appears in the active window with its name selected. Enter a 
new name for the burn folder and press Return.
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4. Drag the items you want to burn to 
disc into the burn folder. If you open 
the burn folder and look at its 
contents, you’ll see that it’s full of 
aliases.

Burning a disc from a burn folder
Burning a disc from a burn folder is 
easy. Just open the folder and click the 
Burn button that appears near the top of 
the window. Then follow the instruc-
tions that appear onscreen to insert a 
blank CD or DVD, name it, choose a 
burn speed, and start the burn.

Tips for using burn folders
4 If you want to, you can create regular folders inside the burn folder and organize the 

burn folder’s contents in them. Folders you create in the burn folders are not created as 
aliases.

4 Mac OS X 10.4 automatically creates a burn folder when you insert a recordable CD or 
DVD and choose the Open Finder action in the dialog that appears. But instead of 
looking like the burn folder icon on the previous page, the disc appears in the Sidebar 
with a burn icon beside it. Drag files onto the Sidebar icon or the disc icon on your 
Desktop. Ejecting the CD without burning files to it automatically creates a standard 
burn folder on your desktop. Not exactly intuitive, but kind of cool.
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4 If you don’t think you’ll ever use a burn folder again, you can delete it. Just drag its icon to the Trash. 
No need to remove items from it—remember, they’re all aliases anyway. The originals remain on disk, 
right where they’ve been all along.

Printing from the Finder
A long, long time ago, back when dying my hair was an option and not a necessity, the Finder’s File menu 
included a Print command. It had two functions: print the contents of the active Finder window and print 
the contents of the selected documents.

The Finder’s Print command was lost to Mac users when Mac OS X came on the scene. (Heck, we 
didn’t care. We had plenty of cool new stuff to play with.) But Mac OS X 10.4 Tiger brings back the Print 
command, although not all of its old functionality. Tiger’s Print command makes it possible to quickly 
print the contents of a selected document. 

Printing a document
Using the Print command is easy:

1. Select the icon for the document you want to print.

2. Choose File > Print.

Your computer opens the application in which the document was created and sends the document to 
the printer. It doesn’t even bother displaying a Print dialog. If you’ve got sharp eyes, you may spot the 
Printing dialog that appears briefly as the document is spooled. But then that disappears as your printer 
gets to work.
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Tips for using the Finder’s Print command
4 The Print command automatically prints to the default printer—that’s the one you either set as the 

default printer in the Print & Fax preferences pane or the one you used last.

4 The Print command can use a bit of polishing to make it really ready for prime time. For example, if 
you select multiple documents before choosing Print, it appears to just open those documents. Hmm.

4 The Print command could be a bit tidier about doing its job. Although it doesn’t display the document 
it prints when it opens the application that created it, it also doesn’t quit the application.



Maria’s Guide to What’s New in Tiger 18

3Spotlight

Spotlight is Mac OS X 10.4’s brand new search feature. Not only is it wicked 
fast and super powerful, but it’s convenient. Indeed, you’ll find it all over 
Mac OS: in the menu bar, in the Find command’s window, in Open dialogs, 

and in System Preferences. Spotlight doesn’t find files and folders—it finds files, 
folders, Address Book contacts, iCal events, Mail messages, and System Prefer-
ences panes.

This chapter explains how you can use Spotlight to quickly find items acces-
sible from your computer and offers some tips for making files easier to find.
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Using the Spotlight Menu
One of the first things you may have noticed right after installing Mac OS X 10.4 Tiger is the blue magnify-
ing glass icon at the far right end of the menu bar. That icon is for the Spotlight menu and it offers the 
absolute quickest way to search for files. After all, its available all the time, no matter what application 
you’re using.

Searching with the Spotlight menu
Searching with the Spotlight menu couldn’t be easier:

1. Click the Spotlight menu icon to display the Spotlight search field.

2. Type a search word or phrase in the search field.

As soon as you begin typing, Spotlight goes to work, looking for 
items that match what you’ve typed so far. The more you type, the fewer 
items it finds. When you’re finished typing, Spotlight is likely to be 
finished searching. It displays the search results in the Spotlight menu. 
As you can see here, it sorts items by type.

Opening a found item
If the item you’re searching for appears on the Spotlight menu, you can 
open it by simply choosing it from the menu.

Viewing all search results
If the item you’re searching for doesn’t appear on the Spotlight menu, 
that doesn’t mean Spotlight hasn’t found it. After all, if there are a lot of 
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items that match your search word or 
phrase, they won’t all fit on the menu. 

You can see how many items 
Spotlight found by consulting the 
Show All item on the menu. The total 
number of items found appears in 
parentheses—41 in the illustration on 
the previous page.

You can see all items Spotlight 
found by choosing Show All from the 
Spotlight menu. A Spotlight window 
appears, listing search results. Clicking 
a more link (such as 31 more... in this 
illustration), displays all the items in 
the group.

As you’ve probably guessed, to 
open an item, all you have to do is double-click it.

Tips for using the Spotlight menu
4 Click options on the right side of the Spotlight window to change the grouping, sorting, or search 

criteria for search results.

4 Change the order in which search results appear by setting options in the Spotlight preferences pane.

4 Click the i button beside an item to show additional information about the item.
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Using the Find Command
The Finder’s Find command has also been modified to utilize Spotlight technology. It’s just as flexible as 
ever, but now its easier to use and faster to get results.

Finding files with the Find command
Using the Find command is pretty straightforward:

1. Choose File > Find or press Command-F to display the New Search window.

2. To search for text, enter a search word or phrase in the Spotlight search box at the top-right corner of 
the window.

3. To choose a search location, click one of the buttons beneath the toolbar. Normally, Computer is 
selected, but you can select a different location or use the Others button to add other search locations.

4. Use the pop-up menus in 
the criteria line(s) beneath 
the location buttons to set 
other search criteria. This 
illustration shows an exam-
ple with two criteria lines 
set. The first one searches 
for items of the Kind (or 
type) Document and the 
second one searches for 
items last opened after 
6/30/2004.



Spotlight

Maria’s Guide to What’s New in Tiger 22

5. To add a criteria line, click the + button at the end of a criteria line and set options in the line that 
appears.

6. To remove a criteria line, click the – button at the end of the line.

Of course, while you’re doing all this, Spotlight is hard at work, finding items that match all of the 
criteria you set. It displays results in the Searching window, which is shown on the previous page.

Working with search results
Once Spotlight has found items that match your search criteria, you can work with them as follows:

4 To open an item, double-click it. 

4 To see a file’s path (location on disk) 
select it and consult the information at the 
bottom of the window.

4 To move an item to another location, drag 
its icon to the destination location.

4 To delete an item, drag its icon to the 
trash.

You get the idea.

Tips for working with the Find command
4 Did I tell you that the Find command finds items that match all search criteria? Of course I did. But I’m 

telling you again, because it’s important. Each time you add a line of search criteria, you narrow the 
search results, reducing the number of items Spotlight finds.
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4 Click the i button beside an item to see more information about that item.

4 You can click the Save button in the Searching window to save the search as a smart folder. (Consult 
Chapter 2 for more information about smart folders.)

Using Spotlight in the Open Dialog
Spotlight is all over the place, including in the standard Open dialog you’ll use with most Mac OS X 
applications. This makes it possible to search for the item you want to open from within the application 
you want to open it in. No more clumsy searching using locations in the Sidebar or the location pop-up 
menu.

Searching for files in the Open dialog
You can find Spotlight in the top-right corner of the 
Open dialog in most applications:

1. While working with an application, choose File > 
Open.

2. In the Open dialog that appears, enter a search 
word or phrase in the Spotlight search box at the 
top of the dialog. Spotlight goes right to work, and 
displays a list of search results. Here’s what it 
might look like in TextEdit.

3. Select the item you want to open and click Open.

Simple, no?
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Tips for using Spotlight in the Open dialog
4 You can click a button at the top of the file list to specify a search location.

4 To restore the Open dialog to its usual appearance without closing and reopening it, clear the contents 
of the search box and, if necessary, select a different location in the dialog’s Sidebar.

Finding System Preferences
Spotlight works in System Preferences, too, helping you to find the preferences pane you need to get a job 
done. And the name “Spotlight” really makes sense in the System Preferences window, as you’ll see here.

Searching for a preferences pane
You can use the Spotlight search box at the top 
of the System Preferences window to find the 
preferences panes that match your search 
criteria:

1. Open the System Preferences window.

2. Enter a search word or phrase in the Spot-
light search box at the top-right corner of 
the window. As usual, Spotlight gets right 
to work. It does two things: It displays a 
menu of configuration options that might 
meet your needs and it highlights, with a 
spotlight, the icons for the preferences 
panes that might meet your needs.



Spotlight

Maria’s Guide to What’s New in Tiger 25

3. Either select the option you want from the menu Spotlight displays or click the icon for the preferences 
pane you want to open.

Tips for finding System Preferences
4 Keep your search word or phrase simple. The simpler it is, the more matches you’ll see.

4 The brighter the spotlight on a preferences pane icon, the more likely it is to meet your needs.

4 Whenever possible, choose a Spotlight menu item rather than a preferences pane. When you choose 
an item from Spotlight’s search results menu in the System Preferences window, Spotlight takes you 
right to the pane that displays the option you want to set.

Customizing Spotlight
You can customize Spotlight using the Spotlight preferences pane. This makes it possible to specify what 
kinds of items are found and what order they appear in search results. It also enables you to exclude 
certain locations from searches.

Setting search results options
Search Results options control the kinds of files that are found and the order in which they appear.

1. In the Spotlight preferences pane, click the Search Results button.

2. To indicate that an item should be included in search results, turn on the check box beside that item. 
Since all items are turned on by default, as shown in the illustration on the following page, you’re 
more likely to turn off the check boxes for the items you don’t want to find.
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3. To change the order in which an item 
appears in the search results, drag the item 
up or down in the list. You can do this 
repeatedly to shuffle the search results so 
they don’t look anything like the list shown 
here.

Closing the Spotlight preferences pane 
automatically saves your changes.

Setting privacy options
The Privacy options in the Spotlight prefer-
ences pane enable you to exclude locations 
you specify from a search.

1. In the Spotlight preferences pane, click the 
Privacy button.

2. Use one of two methods to add a folder or 
disk you don’t want to search to the list: 
Click the + button and use the standard 
Open dialog that appears to locate, select, 
and choose a disk or folder. (You can even 
use Spotlight within the dialog to find it!) 
Or drag the disk or folder icon from a Finder window. The illustration on the next page shows an 
example with two folders added.

3. To remove an item from the list, select it and click the – button.

Closing the Spotlight preferences pane automatically saves your changes.
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Tips for customizing Spotlight
4 You can make Spotlight more useful by 

unchecking the types of items you never 
search for. For example, I never look for 
Bookmarks, so I’ve turned that off on my 
computer.

4 Moving the types of items you search for 
most often to the top of the search results 
list makes these items easier to find without 
a lot of scrolling.

4 Spotlight does not search the Home folders 
for other users. So if you’re computer has 
multiple accounts, don’t expect to search 
someone else’s account from yours using 
Spotlight.

Entering Spotlight 
Comments
The Info window for items in Mac OS X 10.4 now includes a Spotlight Comments field. You can use this 
field to enter comments about an item. Spotlight will check the comments for each item on disk when 
searching.

Entering comments in the Spotlight Comments field is easy:
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1. Select the icon for the item you want to add Spotlight Comments to.

2. Choose File > Get Info or press Command-I to display the Info window for 
the item.

3. If necessary, click the triangle beside Spotlight Comments to display the 
Spotlight Comments field.

4. Type the comments you want to include in the field.

5. Click the Info window’s close button to save the comments.
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4Dashboard

Dashboard is one of the cool new features of Mac OS X 10.4. It enables you, 
with the push of a button or the click of a mouse, to display a number of 
preconfigured applications called widgets. You use the widget you need to 

use, then press a button or click your mouse to get on with your work.

When I first learned about Dashboard, I wasn’t very excited about it. To me, it 
seemed as if Apple were recycling old ideas: Dashboard seemed very similar to 
the old Desk Accessories of Mac OS X 9 and earlier. But I soon grew to love 
Dashboard and appreciate its usefulness. I think you will, too.

In this chapter, I explain how to activate and close Dashboard, give you an 
overview of the widgets that come with Mac OS X 10.4, and explain how you 
can configure widgets so they’re ready to use when you need them.
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Activating & Closing Dashboard
When you activate Dashboard, you basically put whatever you’re doing on hold. The screen goes dark 
and the widgets you used last appear. When you’re finished, you close Dashboard to get back to work.

Activating Dashboard
There are two ways to 
activate Dashboard:

4 Press the F12 key. 
(This is my preferred 
method.)

4 Click the Widget icon 
on the Dock. (I think 
this is Apple’s pre-
ferred method, since 
Apple keeps saying 
that widgets are 
“only a click away.”)

There’s a third way, 
too, but it requires you 
to set options in the 
Dashboard and Exposé 
preferences pane. I’ll let 
you explore that on your 
own.
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(In case you’re wondering why I’m monitoring the weather at three locations, here’s the scoop. I live in 
Wickenburg. I have some vacation property about 40 miles south of the Grand Canyon and was there last 
weekend. And I’m planning a trip to Sacramento tomorrow, which is why I’m still working at 7:21 PM. 
Got to get this book done!)

Closing Dashboard
Similarly, there are two ways to close Dashboard:

4 Press the F12 key.

4 Click anywhere onscreen except on a widget.

Using the Widget Bar
The Widget Bar, which is illustrated on the following page, is where you can find widgets to add to your 
dashboard. All installed widgets are listed in alphabetical order. To add one to your dashboard, simply 
drag it from the Widget Bar to the place you want it to appear onscreen.

Displaying the Widget Bar
Displaying the Widget Bar is easy:

1. If Dashboard isn’t already showing, display it.

2. Click the big round + button at the bottom-left corner of your screen.

The Widget Bar appears. The number of widgets that are displayed varies depending on your screen 
resolution and the number of widgets installed on your computer. You can click the arrow on the left or 

Do it slowly
Want a weird, useless tip? 
Of course you do! Here it 
is: Pressing Shift-F12, 
opens or closes Dash-
board in slow motion.
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right end of the Widget 
bar to display widgets 
that aren’t showing.

Meet the Widgets
Here’s a quick list of the 
widgets that come with 
Mac OS X 10.4 Tiger:

4 Address Book gives you access to the contacts you maintain in the Address Book application.

4 Calculator gives you a handy calculator.

4 Calendar displays a month-at-a-glance calendar.

4 Dictionary lets you look up word definitions and synonyms.

4 Flight Tracker lets you find commercial airline flights between cities and see the location and speed of 
airplanes enroute.

4 iTunes offers a handy control for iTunes so you don’t have to display its application window.

4 Phone Book looks up yellow pages listings in an online phone book.

4 Stickies is a Dashboard version of the Stickies application.

4 Stocks (see image below) enables you to get slightly delayed stock quotes.

4 Tile Game is the digital version of the old tile game.

4 Translation enables you to translate text between two languages.
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4 Unit Converter converts between different units and can perform currency conversions.

4 Weather displays a five-day forecast for a specific city.

4 World Clock displays the time in the city of your choice.

Opening a Widget
There are two ways to open a widget:

4 Click the widget in the Widget Bar. This opens the widget in the middle of Dashboard. You can move it 
to another location by dragging it there.

4 Drag the widget from the Widget Bar to the location you want it to appear. Not only does this put the 
widget where you want it without moving it, but on some computers, it shows a cool looking widget 
on water visual effect. (Please don’t ask me which computers. For some reason, it displays this effect 
on my dual processor G5 but won’t display it on my 800 MHz G4 eMac. That gives me the idea that it 
has something to do with processing power.)

Closing a Widget
You should notice a close button, which looks like an X in a circle, in the upper-left 
corner of each widget when the Widget Bar is displayed. This is the close button.

4 To close a widget with the Widget Bar displayed, click the widget’s close button.

4 To close a widget when the Widget Bar is not displayed, hold down Option, 
point to the widget you want to close, and click the close button that appears. 
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Hiding the Widget Bar
The Widget Bar has its very own close button. It looks like an X in a circle and it appears right above the 
left side of the widget bar. Click it to hide the Widget Bar from sight.

Tips for using the Widget Bar
4 The following widgets require an Internet connection to work: Flight Tracker, Phone Book, Stocks, 

Translation, Unit Converter (for currency conversions only), and Weather.

4 When you activate Dashboard, it automatically displays the widgets you used last. So if you arrange 
the widgets you use most in Dashboard and leave them open, you’ll always see them as soon as you 
activate Dashboard, eliminating the need to mess around with the Widget Bar.

Setting Widget Options
Many widgets can be configured by setting options on the “back” side of the widget.

Flipping a widget
To get to the back side of a widget, you must flip the widget:

1. Point to the widget you want to flip.

2. A tiny i button should appear, probably in the lower-right corner of 
the widget. Click this button.

The widget flips over to display its back side.

Flipping a what?
Don’t you just love it when a 
heading sounds like it means 
something other than what it 
really means?
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Setting options
Once you’re looking at the back side of a 
widget, you can enter text or values, choose 
menu options, toggle check boxes, click 
buttons, and do other typical Mac OS tasks to 
set options. 

Since the options for each widget are different, I won’t go into them in detail here. (Besides, they’re 
described in detail in Mac OS X 10.4 Tiger: Visual QuickStart Guide and my editors at Peachpit would kill 
me if I repeated them on these digital pages.) In most cases, you should be able to figure out what to 
enter, choose, toggle, or click. Experiment! You can’t break anything. Close a widget and reopen it to start 
all over again.

Tips for setting widget options
4 When you close a widget, all custom settings are lost. The next time you open the widget, it appears 

with default values. (That’s another good reason to set up widgets in Dashboard and leave them open 
if you expect to use them over and over.)

4 Not all widgets can be customized by setting options. Calendar, for example, has no back side.

Getting More Widgets
Did you happen to notice the More Widgets button that appears when you display the Widget Bar? Click-
ing this button displays the Dashboard Widgets page on Apple Computer’s Web site, www.apple.com/
downloads/macosx/dashboard/. That’s a good place to start your search for additional widgets.

http://www.apple.com/downloads/macosx/dashboard/
http://www.apple.com/downloads/macosx/dashboard/
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The selection of widgets on the Dashboard Widgets page seems to be growing exponentially. There 
were about a dozen there when Tiger was released on April 29; a week later there were over 100. My 
favorites? Hula Girl, which puts a dancing hula girl on your Dashboard (where she belongs!), and Sloth-
Cam, which enables you to get updated images from the Webcam of your choice.

Tips for getting more widgets
4 Widgets come in several flavors: freeware wid-
gets are free, shareware widgets are fully functional 
but require you to pay a fee if you continue using 
them past a trial period, and demo widgets are par-
tially functional or expire after a certain period unless 

you pay a fee.

4 Some widgets only work with other software. Be sure to read the 
system requirements before downloading a widget. If a widget 
requires software that isn’t installed on your computer, it probably 
won’t work.

4 If a widget isn’t installed automatically when you download it, 
you can install it by dragging its icon to the Widgets folder inside 
the Library folder in your Home folder.

Check out my view!
Want to see the current view from 
my office window? Use SlothCam 
(or a Web browser) to visit  
http://www.wickenburg-az.com/
images/webcam.jpg.

http://www.wickenburg-az.com/images/webcam.jpg
http://www.wickenburg-az.com/images/webcam.jpg
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5Automator

Automator is Apple’s new task automation feature. With Automator, you 
build workflows consisting of actions that make up the steps of a specific 
task. When you run the workflow, Automator repeats the actions to perform 

the task.

For example, suppose you start every day by printing a list of your iCal 
events. You’d open iCal, display the current date, and use the Print command to 
print the list. Not many steps, but wouldn’t it be nice to cut it down to just one? 
With Automator, you can turn those steps into actions in a workflow and per-
form the entire task by just running the workflow. Since your computer can 
perform the steps much faster than you, the task is complete in far less time.

This chapter explains how you can get started with Automator.
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Creating a Workflow
You create a workflow within the Automator application, which you can find in your Applications folder. 
Build the workflow by adding and configuring actions, then save the workflow so you can use it again and 
again.

Opening 
Automator
When you 
install Mac 
OS X 10.4 
Tiger, 
Automator is 
automatically 
installed in 
your Applica-
tions folder. 
Double-click 
the Automa-
tor icon to 
display an 
Untitled 
Automator 
workflow 
window like 
the one 
shown here.
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The window is divided into four columns and panes:

4 The Library column lists all of the application libraries available for use with Automator, as well as 
example workflows that come with Automator and any workflows you’ve created and saved.

4 The Action column lists all of the actions for the item selected in the Library column. For example, if 
you select Applications, it lists all actions. If you select Finder, it lists only the actions available for 
Finder.

4 The small pane at the bottom left of the window provides additional information about Getting Started 
with Automator or about the selected action.

4 The big pane on the right side of the window is where you add actions and configure them to build 
your workflow.

Adding actions
You add actions by dragging them from the Action 
column to the workflow area on the right side of 
the window. Then configure them for the options 
you want.

1. In the Library column, select the application 
that will perform the action.

2. Drag the action you want to add to the work-
flow from the Action column to the workflow 
area. The action appears in its own pane, as 
shown here.

3. Set options for the action in the workflow area.
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Understanding input and results
In many cases, an action will take results from a 
previous action as its input. For this to work properly, 
the input type from one action must match the results 
type from the previous action. You can see if they 
match by checking the types at the bottom of one 
action and the top of the next action. The sample 
workflow shown here shows how they might match 
up.

Of course, you don’t  have to use the results from 
one action as the input for the next action. Two 
independent actions can be included consecutively 
in the workflow if you need them to.

Using results for input
To use the result of one action as the input for the next action:

1. Confirm that the two types match.

2. Choose use Results from Previous Action from the 
pop-up menu for the input type. The action panes 
will appear linked, as shown for all actions at the 
top of this page.
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Not using results for input
To not use the result of one action as the input for the 
next action, choose Ignore Results from Previous 
action from the pop-up menu for the input type. The 
action panes will appear as separate, unlinked panes, 
as shown here.

Saving the workflow
When you’re finished creating your workflow, save it:

1. Choose File > Save to display a Save As dialog.

2. Enter a name for the workflow in the Save As box.

3. Choose a location to save the file.

4. Choose a format from the File Format pop-up menu: Work-
flow saves the workflow as a workflow file, which must be 
run from within Automator and Application saves the 
workflow as an application, which can be run from the Finder.

5. Click Save. The name of the workflow appears in the title bar.

Tips for creating a workflow
4 If the results type for one action doesn’t match the input type for the next action, both types will 

appear in red in the workflow area.
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4 Workflows you save should appear in the My Workflows folder in the Library column of the workflow 
window.

4 You can share workflows with your friends. Just send them the workflow file you created. If the actions 
are valid on their computers, the workflow should work flawlessly.

Running a Workflow
Once you’ve built and saved a workflow, you can run it. How you run it depends on how you saved it.

Running a workflow from within Automator
To run a workflow saved as a workflow:

1. Open Automator.

2. Find the workflow in the My Workflows folder in the Library column and double-click it to open it.

3. Click the Run button in the upper-right corner of the window. The action runs.

Running a workflow from the Finder
To run a workflow saved as an application, double-click the application’s icon in the Finder. The workflow 
opens and runs.

Tips for running workflows
4 If Automator encounters an error while running a workflow, it displays an error message. Otherwise, it 

just completes each action of the workflow as you configured it and plays a tone when it’s finished.
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4 Automator is a bit sloppy. It opens all of the applications it uses, but doesn’t quit any of them when it’s 
done.

Getting More Actions and Workflows
As you may have guessed, Apple is making automator actions and workflows available for download from 
the Apple Web site. Visit www.apple.com/downloads/macosx/automator/ to see what’s available.

Tips for getting more actions and workflows
4 Actions and workflows come in several flavors: freeware actions and workflows are free, shareware 

actions and workflows are fully functional but require you to pay a fee if you continue using them past 
a trial period, and demo actions and workflows are partially functional or expire after a certain period 
unless you pay a fee.

4 Some actions and workflows only work with other software. Be sure to read the system requirements 
before downloading an action or workflow. If an action or workflow requires software that isn’t 
installed on your computer, it probably won’t work.

4 If an action isn’t installed automatically when you download it, you can install it by dragging its icon 
to the Automator folder inside the Library folder in your Home folder.

http://www.apple.com/downloads/macosx/automator/
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6Family Controls

Although the Internet offers a wealth of useful and interesting information, it 
can also be a rather trashy place. Think of it as a huge library that just hap-
pens to stock porn among the reference books.

Responsible parents need to keep tabs on what their kids are doing online 
and prevent them from accessing inappropriate material or being contacted by 
unsavory characters. That’s where Mac OS X 10.4’s new family controls comes 
in. It enables a parent to control a family member’s access to the Internet, as 
well as material right on the computer’s hard disk.

This chapter introduces the family controls feature and explains how you can 
get started using parental controls.
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Accounts and Family Controls
Tiger’s family controls feature works with its multiple user account feature. In other words, to use family 
controls, you must set up a separate account for each user you want to control access for.

How it works: An example
Suppose you’re a mom with a husband and two kids aged 15 and 6. 

Chances are, you and your husband will share one account, with administrator privileges, to use the 
computer. You might want to create two more accounts, one for each child, and assign different privileges 
to them. Your 15-year-old may get access to most applications and be allowed to receive e-mail from 
anyone. But your 6-year old might be limited to a few educational games and be prevented from receiv-
ing e-mail from anyone you don’t know.

Setting up accounts
The ability to set up user accounts and log in and out of a user account is not new in Tiger and, thus, 
beyond the scope of this eBook. It’s covered extensively in Mac OS X 10.4 Tiger: Visual QuickStart Guide, 
so if you haven’t got a clue how to proceed, I highly recommend that you track down this book and buy 
it. (And yes, that’s another shameless plug for my book. I have a mortgage to pay, you know.)

I will give you a hint to get started, however. Open the Accounts preferences pane. That’s where you’ll 
set up Parental Controls options, so you’ll get a closer look at it in a moment anyway.
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Setting Parental Controls
You set up the family controls feature by setting Parental Controls options in the Accounts preferences 
pane for the account you want to control.

Accessing Parental Controls settings
Dive into the Parental Controls settings for a user like this:

1. If necessary, log in with an administrator 
account.

2. Choose Apple > System Preferences to 
open the System Preferences window.

3. Click the Accounts button to display the 
Accounts preferences pane.

4. Click the lock icon at the bottom of the 
window. Then enter an administrator name 
and password in the Authenticate dialog 
that appears and click OK.

5. In the account list, select the account of 
the person you want to set controls for.

6. Click the Parental Controls button to dis-
play the main pane of options, shown here. 
(Okay, so I don’t have any kids. But I’m 
worried about what my parrot might see if 
he happens to start using my computer.)
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Control categories and settings
As shown in the previous illustration, you can set controls in five different categories:

4 Mail enables you to specify who the user is allowed to exchange e-mail with. When you enable this 
option, you can click Configure to display a window where you list valid e-mail addresses, as well as 
the address that e-mail should be forwarded to for permission by unauthorized senders.

4 Finder & System lets you limit access to the Finder, Mac 
OS X, and software installed on the computer. This is a 
powerful group of settings, many of which were formerly 
available in the Limitations pane of the Accounts prefer-
ences pane for a user under Mac OS X 10.3 Panther. As 
shown in this illustration, you can set some limits or 
enable Simple Finder to really limit things. You can also 
control access to certain Finder activities and software.

4 iChat enables you to specify who the user is allowed to 
chat with. When you enable this option, you can click 
Configure to display a window where you list valid AIM 
addresses.

4 Safari makes it possible to limit access to Internet sites that 
you approve. Configuring this option is a bit more time-
consuming than the others. First leave this option turned 
off, then quit System Preferences, and log out. Log back in 
using the  account you are setting controls for, then launch Safari and add bookmarks for the sites that 
the user is allowed to access. Quit Safari, log out, and log back in with an administrator account. 
Finally, turn on this option for the user account. (Whew!) The user will only be able to access pages on 
bookmarked sites.
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4 Dictionary prevents the user from looking up certain words 
(you know which ones) in the Dictionary application or 
widget.

Tips for setting parental controls
4 As Mac OS X will tell you, you cannot set parental controls 

for someone who has administrator privileges.

4 If you’re going to use the family controls feature, don’t tell 
your kids what your account’s user ID and password are. (My 
mother once told my kid brother what the password was to 
unlock the cable TV channels because she could never figure 
out how to do it on her own.)

4 Set appropriate controls for each of your kids and explain to 
them why you’ve done what you’ve done.

If you love your kids,  
you’ll limit their computer time
Computers are great educational tools. 
Computer skills are required to suc-
ceed in almost every business. But 
don’t let those two statements give you 
an excuse to give your kids unlimited 
time in front of a computer screen.
Personal interaction with people and 
participation in sports and other 
outdoor activities are an important part 
of growing up. Online chats and video 
games aren’t substitutes. Help your 
kids get the most out of their childhood 
by setting limits to the time they spend 
in front of any screen, whether it’s 
connected to your computer or your 
television receiver.
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.Mac Sync

If you have more than one computer and have 
been using Mac OS X for a while, you probably 
already know the value of iSync to synchronize 

Address Book contacts, iCal events, and Safari 
bookmarks. After all, isn’t it nice to have the same 
information on all of your Macs?

Mac OS X 10.4 lets you synchronize this infor-
mation, as well as keychains, mail accounts, and 
mail rules, signatures, and smart mailboxes. All you need is a .Mac account, an 
Internet connection, and Tiger’s .Mac preferences pane.

This chapter explains how to set up .Mac sync on your computers.

7
Don’t have a .Mac account?
You need a .Mac account to 
use the .Mac sync feature. So if 
you don’t have one and you 
don’t want to get one, don’t 
bother reading this chapter.
Need to know more about 
.Mac? Visit the .Mac home 
page, www.mac.com.

http://www.mac.com
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Setting Up .Mac Synchronization
Forget everything you might know about using iSync to synchronize data between two computers. That 
was the Panther method; you do things differently in Tiger. Here’s how.

Accessing Sync Options
You set up .Mac synchronization options in the 
Sync pane of the .Mac preferences pane:

1. Choose Apple > System Preferences to 
display the System Preferences window.

2. Click the .Mac icon to display the .Mac 
preferences pane.

3. Click the Sync button to display synchroni-
zation options, as shown here.

Setting Sync options
Setting Sync option is as easy as toggling a few 
check boxes and choosing a menu command:

1. In the Sync options of the .Mac preferences 
pane, turn on the Synchronize with .Mac check box.

2. Choose an option from the pop-up menu to specify whether you want to synchronize manually, auto-
matically, or periodically (every hour, day, or week).

3. Turn on the check box for each type of information you want to synchronize.
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4. To display a status icon and Sync menu in the menu bar, turn on the Show status in menu bar check 
box.

Tips for setting up .Mac synchronization
4 You must enter your .Mac member name and password in the Account options of the .Mac prefer-

ences pane to set Sync options.

4 Not sure how often you should synchronize? I chose Every Hour on my desktop Mac, which I use 
regularly throughout the workday, and Automatically on my PowerBook, which doesn’t always have 
access to an Internet connection.

4 If you elect to synchronize manually, no data will be synchronized until you either click the Sync now 
button in the Sync options of the .Mac preferences pane or use commands on the Sync status menu in 
the menu bar to start a synchronization when you want to.

First Time Synchronization
The first time you synchronize a computer, you’ll prob-
ably see an Alert dialog like the one shown here for at 
least one type of information being synchronized. You’ll 
have three options:

4 Merge data on this computer and .Mac takes the 
existing information on your computer and merges it 
with whatever information is already stored on .Mac 
from another computer.
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4 Replace data on .Mac takes the existing information on 
your computer and uses it to completely replace whatever 
information is already stored on .Mac from another com-
puter.

4 Replace data on this computer erases the existing informa-
tion on your computer and replaces it with whatever 
information is stored on .Mac from another computer.

Using Advanced Options
The Advanced options of the .Mac preference 
pane, which is shown here, lets you do three 
things:

4 See which computers are registered with 
.Mac for synchronization and when they 
were last synchronized.

4 Unregister a computer so its data is no 
longer stored on .Mac. This turns off the 
Synchronize with .Mac check box in the 
Sync options and disables synchronization 
on that computer.

4 Reset the sync data on a registered com-
puter or .Mac so you can replace it. This is, 
in effect, forcing the .Mac sync feature to 
do a first time synchronization all over 

Choose wisely!
Don’t just pick any option when confront-
ed with the Alert dialog shown on the 
previous page. Choosing the wrong option 
could result in data loss! 
For example, replacing the data on .Mac 
with data on a brand new (read that 
“empty”) computer will erase data on 
.Mac and could cause that data to be 
erased on other computers.
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again. If you select a registered computer and click the 
Reset Sync Data button, a dialog like the one shown here 
appears. Choose an option from the pop-up menu, select a 
replace data direction, and click Replace.
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8Other Improvements

Way back in Chapter 1, I told you that Apple said it added over 200 fea-
tures to Mac OS X for Tiger. I covered a bunch of them so far. But if you 
think I’m going to cover the rest in the remaining pages, think again. If I 

make this file too big, no one will want to download it.

Instead, I’m going to concentrate on the features that I think you’ll find most 
useful. How do I know what you’ll find useful? Well, I’m guessing based on 
what I find most useful.

Read on to learn about new features in the Safari, iChat, Mail, and Address 
Book applications.
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What’s New in Safari
Safari was on the receiving end of a number of new features that make it more flexible and a better choice 
than “brand IE” for surfing the ‘Net.

RSS news feed
Safari now has built-in RSS (really simple syndication) reader capabilities built right in. This format, which 
is available for many Web sites and blogs, simplifies page viewing.

There are a few ways you can 
open the RSS feed for a Web page 
or site. Here are two of them:

4 If the blue RSS button appears 
in the address bar at the top of 
the Safari window while 
viewing a Web page, click the 
button to view the RSS feed. 
Try it for yourself by visiting 
www.apple.com and clicking 
the RSS button you see in the 
address bar after the page 
loads.

4 Enter the URL for an RSS feed 
in the address bar at the top of 
the Safari window and press 
Return. To view the page 
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shown on the preview page (for the current content, of course), enter feed://www.apple.com/main/
rss/hotnews/hotnews.rss.

E-mail page or link
Two new commands under Safari’s File menu make it quick and easy to e-mail Web content or URLs:

4 Mail Contents of this Page creates a new e-mail message that includes all of the formatting to repro-
duce the current Web page.

4 Mail Link to This Page creates a new e-mail message that includes the URL for the current Web page.

Private browsing
Ever want to surf on a shared computer without letting others know where you’ve been? Choose Safari > 
Private Browsing and click OK in the confirmation dialog that appears.

From that point forward, Web pages aren’t added to history, items are removed from the Downloads 
window, information isn’t saved for AutoFill, and searches are not added to the Google search box’s 
menu. To disable this feature, choose Safari > Private Browsing again.

What’s New in iChat
iChat (or iChat AV, if you want to get technical about names), has been improved to add a few new fea-
tures. If you use iChat as often as I do—primarily to bug my editors throughout our workday—you might 
find these useful.

feed://www.apple.com/main/rss/hotnews/hotnews.rss
feed://www.apple.com/main/rss/hotnews/hotnews.rss
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Multi-person conferencing
You can now chat with more than one person at a time:

4 Multi-person audio conferencing makes it possible to conduct audio 
conferences with up to 10 people at a time.

4 Multi-person video conferencing makes it possible to conduct a video 
conference with up to three people at a time.

iChat and iTunes integration
This latest version of iChat makes it possible to display the currently playing 
iTunes track as your iChat status. So now everyone can know how weird your 
tastes in music are.

What’s New in Mail
Mail got a bunch of improvements to make it more useful. (It got me to switch back from Entourage. Just 
don’t ask me why I went to Entourage in the first place.) Here are the ones I think are best.

Smart mailboxes
The smart mailboxes feature is like automatic search results. You set up a smart mailbox with search 
criteria and Mail automatically fills it with messages that match.

And if that isn’t enough, smart mailboxes can be synchronized via .Mac Sync (as discussed in Chapter 
7), so all of your computers can have the same mailbox—and smart mailbox—setup.
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Spotlight searching
Spotlight is all over Mac OS X 10.4, including 
Mail. To find messages, simply enter a search 
word or phrase in the Spotlight search box at the 
top-right corner of Mail’s main window. The 
window changes to list search results, as shown 
here.

Can’t get any quicker or easier than that.

Slide show
This is my favorite new mail feature. Suppose a 
friend of yours sends an e-mail message with a 
bunch of photos attached. You can turn the message into an impromptu slide show, just by clicking the 
Slide Show button that appears near the attachment information in the message header.

What’s New in Address Book
Address Book has also been improved to add some new features. Here are the ones I find most useful.

Smart groups
The smart groups feature is like automatic search results for Address Book. You create a smart group by 
specifying search criteria. Address Book automatically adds matching contacts to the group.
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Spotlight contact
Spotlight is everywhere in Mac OS X 
10.4. (Didn’t I tell you that?) It’s even 
in Address Book.

Select a contact name in Address 
Book’s Name list, then choose Spot-
light “Contact Name” from the short-
cut menu, where Contact Name is the 
actual name of the contact. A Spotlight 
window, like the one shown here, 
appears, listing documents, messages, 
and other items related to that contact.

Address Book sharing
Mac OS X 10.4 now makes it possible 
to share your Address Book contacts 
with .Mac users running Tiger. This makes it possible to view another user’s contacts in Address Book.

To share your Address Book, choose Address Book > Preferences and click the Sharing button in the 
preferences window that appears. Turn on the Share your Address Book check box and use the + button 
beneath the list to add the names of people you want to share your Address Book with. Click the Send 
Invite button so they can access your Address Book.

If you get an invitation to share someone else’s Address Book, click the link in the invitation message 
and follow the instructions that appear onscreen to add the user’s Address Book to your Address Book 
Group list.

Either way, sharers and sharees will all need an Internet connection and .Mac account.
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